Configurar o registro de eventos seguro do
NetFlow no Firepower Threat Defense
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Introduction

Este documento descreve como configurar o NetFlow Secure Event Logging (NSEL) no Firepower
Threat Defense (FTD) através do Firepower Management Center (FMC).

Prerequisites

Requirements
A Cisco recomenda que vocé tenha conhecimento destes tépicos:

. Conhecimento do CVP
. Conhecimento de FTD
- Conhecimento da politica FlexConfig

Componentes Utilizados
As informacgdes neste documento sao baseadas nestas versdes de software e hardware:

. FTD versao 6.6.1
- FMC versao 6.6.1

The information in this document was created from the devices in a specific lab environment. All of
the devices used in this document started with a cleared (default) configuration. Se a rede estiver
ativa, certifique-se de que vocé entenda o impacto potencial de qualquer comando.

Informagdes de Apoio

Este documento descreve como configurar o NetFlow Secure Event Logging (NSEL) no Firepower
Threat Defense (FTD) através do Firepower Management Center (FMC).

Os objetos de texto FlexConfig sdo associados a variaveis usadas nos objetos FlexConfig
predefinidos. Objetos FlexConfig predefinidos e objetos de texto associados sdo encontrados no



FMC para configurar o NSEL. Ha quatro objetos FlexConfig predefinidos no FMC e trés objetos
de texto predefinidos. Os objetos FlexConfig predefinidos sdo somente leitura e ndo podem ser
modificados. Para modificar os parametros do NetFlow, os objetos podem ser copiados.

Os quatro objetos predefinidos estao listados na tabela:

FlexConfig Object Name
Netflow Add Destination
Netflow_Set Parameters
Netflow_Delete_Destinations

Netwflow Clear Parameters

Description

Creates and configures a NetFlow export destination
Sets globla parameters for NetFlow export

Deletes a NetFlow export destination

Restores Netflow export global default settings

Os trés objetos de texto predefinidos estao listados na tabela:

Text Object Name
netflow_Destination
netwflow_Event_Types

netflow_Parameters

Configurar

Description

Define the single NetFlow export destination’s interface, destination IP
address and UDP port number for NetFlow.

Define NetFlow events based on event type

Define values for active refresh-interval, delay flow-create and template

timeout-rate.

Esta se¢cédo descreve como configurar o NSEL no FMC através de uma politica FlexConfig.

Etapa 1. Defina os parametros dos Objetos de Texto para Netflow.

Para definir os parametros variaveis, navegue até Objetos > FlexConfig > Objetos de texto. Edite
o objeto netflow_Destination. Defina o tipo de variavel multipla e a contagem definida como 3.
Defina o nome da interface, o endereco IP destino e a porta.

Neste exemplo de configuragao, a interface € DMZ, o endereco IP do coletor NetFlow &

10.20.20.1 e a porta UDP é 2055.



Edit Text Object @

Name:
Description:
Variable Type Count
Multiple 3 =
1 DMZ

2 10.20.20.1
3 2055

Observagao: Sao usados valores default para netflow_Event_Types e netflow_Parameters.

Etapa 2. Configure um Objeto de Lista de Acesso Estendida para corresponder ao trafego
especifico.

Para criar uma lista de acesso estendida no FMC, navegue até Objetos > Gerenciamento de
objetos e no menu a esquerda, em Lista de acesso selecionar Estendido.Clique em Adicionar
Lista de Acesso Estendida.

Preencha o campo Nome. Neste exemplo, o nome é flow_export_acl. Clique no botao Adicionar.
Configure as entradas de controle de acesso para corresponder ao trafego especifico.

Neste exemplo, o trafego do host 10.10.10.1 para qualquer destino e o trafego entre os hosts
172.16.0.20 e 192.168.1.20 € excluido. Qualquer outro trafego é incluido.



Edit Extended Access List Object [+

Name

[ how, export_aci |

Entries (3)

Sequence Action Source Source Port Destination Destination Port

1 @Elock 10.10.101 Any Any Any VR 1
2 @Block 172.16.0.20 Any 192.168.1.20 Any /s
3 SAllow Any Any Any Any s u

Allow Overrides

Etapa 3. Configure um objeto FlexConfig.

Para configurar os Objetos FlexConfig, navegue até Objects > FlexConfig > FlexConfig Objects e
cligue no botdo Add FlexConfig Object.

Defina o mapa de classe que identifica o trafego para o qual os eventos do NetFlow precisam ser
exportados. Neste exemplo, o nome do objeto é flow_export_class.

Selecione a Lista de acesso criada na Etapa 2. Clique em Insert > Insert Policy Object > Extended
ACL Obiject e atribua um nome. Em seguida, clique no botdo Add. Neste exemplo, o nome da
variavel é flow_export_acl. Click Save.



Insert Extended Access List Object Variable ®

Variable Name:

[ flow_export_acl \

Description:
Available Objects C' Selected Object
‘ Q_ Search D4 ‘ flow_export_acl v

flow_export_acl

Adicione as préximas linhas de configuragdo no campo em branco a direita e inclua a variavel
definida anteriormente ($flow_export_acl.) na linha de configuragdo match access-list.

Observe que um $ simbolo inicia 0 nome da variavel. Isso ajuda a definir que uma variavel vem
depois dela.

class-map flow_export_class
match access-list $flow export_acl

Clique em Save quando terminar.




Edit FlexConfig Object @
Name:
flow_export_class

Description:

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.
Insert ~ Deployment: Everytime + | Type: | Append

class-map flow export class
match access-list $flow export acl

v Variables
Name Dimension Default Value Property ) Override Description
(Type:Name)
low_export_class SINGLE flow_export_acl EXD_ACLA...

Etapa 4. Configurar o destino do Netflow

Para configurar o destino do Netflow, navegue até Objects > FlexConfig > FlexConfig Objects e
filtre por Netflow. Copie o objeto Netflow_Add_Destination. O Netflow_Add_Destination_Copy é
criado.

Atribua a classe criada na Etapa 3. Vocé pode criar um novo mapa de politica para aplicar as
acdes de exportagao de fluxo as classes definidas.

Neste exemplo, a classe € inserida na politica atual (politica global).

## destination: interface_nameif destination_ip udp_port
## event-types: any subset of {all, flow-create, flow-denied, flow-teardown, flow-update}
flow-
export destination S$netflow_Destination.get(0) S$netflow Destination.get(l) S$netflow_Destination.
get(2)
policy-map global_policy
class flow export_class
#foreach ( $Sevent_type in S$netflow_Event_Types )
flow-export event-type Sevent_type destination $netflow_Destination.get (1)
#end

Clique em Save quando terminar.



Edit FlexConfig Object (1]

Name:

| Netflow_Add Destination_Copy

Description:

Create and configure a NetFlow
export destination.

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CL| before deployment.
Insert » Deployment: Once v | Type: | Append v

f## destination: interface nameif destination ip udp port
#4 event-types: any subset of {all, flow-create, flow-denied, flow-teardown, flow-update}
flow-
export destination Spetflow Destination.get (0) Snetflow Destination.get(l) Snetflow Destination.get(2)
policy-map global policy
class flow export class
#foreach (_$eventitype in $netflow Event Types )
flow-export event-type $event type destination $S$netflow Destination.get (1)

#end
v Variables
Name Dimension Default Value r;s:z:ime] Override Description
netflow_Event_Types MULTIPLE [all] FREEFORM: false This variable provides the glo...
netflow_Destination MULTIPLE [DMZ, 10.20.20.... FREEFORM:... false This variable defines a single ...

Etapa 5. Atribuir a politica FlexConfig ao FTD

Navegue até Devices > FlexConfig e crie uma nova politica (a menos que ja haja uma criada para
outra finalidade e atribuida ao mesmo FTD). Neste exemplo, o FlexConfig ja foi criado. Edite a
Politica FlexConfig e Selecione os objetos FlexConfig criados nas etapas anteriores.

Neste exemplo, os parametros de exportacao padrao do Netflow sdo usados, portanto, o
Netflow_Set_Parameters é selecionado. Salve a alteragdo e implante-a.



F|EXCDI“Iﬁg po“cy You have unsaved changes [ Preview Config |

Enter Description

Palicy Assignments (1)

" Selected Prepend FlexConfigs

Available FlexConfig C FlexCanfig Object

0] Narme Description
netflow X
~ User Defined
- How Add
& Methow i
7 Metfiow_Delete_Destination_Copy
o Matflow_sxport_Cogy
"B Methow_Set_Parameters_Copy
* Systam Dafined
"B Metfow_Add_Destination =7 Selected Append FlexConfigs
«f Netfiow_Clear_Parameters " Marme Description

o2 Metfiow_Delete_Destination

[ oo sormrens [ o

2 Netflow_Add_Destination_Copy Create and configure a NetFlow export destination. Ow
3 Netflow_Set_Parameters Set global parameters for NetFlow export, Qw
How To

Observagao: para fazer a correspondéncia de todo o trafego sem a necessidade de
correspondéncia com trafego especifico, vocé pode pular das Etapas 2 a 4 e usar os
Objetos NetFlow predefinidos.

FIEXCOnﬁgpﬂliCV You have unsaved changes | Preview Config
Enter Description
Policy Assignments (1)
"% Selected Prepend FlexConfigs
Avallable FlexConfig & FlexConfig Object
o MName Description
netflow X

* User Defined

"8 Netflow_Add_Destination_Copy

=7 Netflow_Delete_Destination_Cogpy

 Netflow_export_Copy

"8 Metfiow_Set_Parameters_Copy
' System Defined

]

=¢ Netflow_Cloar_Paramaters #  MName Description

.. Metflow_Delete_Destination

= 1 Netflow_Set_Parameters Set global parameters for NetFlow export. Qw

B Metflow_Set ametars

2 Metflow_sdd_Destination Create and confgure a NetFlow export destination. Q i
[ ]

Observagao: para adicionar um segundo coletor NSEL ao qual os pacotes NetFlow sdo

enviados. Na Etapa 1, adicione 4 variaveis para adicionar o segundo endereco IP do coletor
Netflow.



Edit Text Object @

Name:

Description:

Variable Type Count
Multiple 4 3

—

DMZ
10.20.20.1
2055

L= w N

10.20.20.1

Na Etapa 4, adicione a linha de configuragao: flow-export destination $netflow_Destination.get(0)
$netflow_Destination.get(1) $netflow_Destination.get(2)

Edite a variavel $netflow_Destination.get para a variavel de correspondéncia. Neste exemplo, o
valor da variavel é 3. Por exemplo:

flow-

export destination S$netflow_Destination.get(0) S$netflow Destination.get(l) S$netflow_Destination.
get (2)

flow-

export destination S$netflow_Destination.get(0) S$Snetflow Destination.get(3) S$netflow_Destination.
get (2)

Adicione também a segunda variavel $netflow_Destination.get na linha de configuragéo: flow-
export event-type $event_type destination $netflow_Destination.get(1). Por exemplo:

flow-export event-
type Sevent_type destination S$Snetflow Destination.get(l) $netflow_Destination.get (3)

Valide essa configuragao conforme visto na imagem abaixo:



Edit FlexConfig Object

Name:
Netflow_Add_Destination_Copy |

Description:

Create and configure a NetFlow
export destination.

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

‘ Insert » ‘ Deployment: | Once v | Type: | Append v

## destination: interface nameif destination_ip udp_port

## event-types: any subset of {all, flow-create, flow-dénied, flow-teardown, flow-update}
flow-

policy-map global policy
class flow export class
fiforeach ( Sevent_type in $Snetflow_Event Types )
flow=-export event=-

fend
¥ Variables
Name Dimension Default Value ?S;;ﬁzme] Override Description
netflow_Event_Types MULTIPLE [all] FREEFORM:... false This variable provides the glo...
netflow_Destination MULTIPLE [DMZ, 10.20.20.... FREEFORM:... false This variable defines a single ...

Cancel

Verificar

A configuragao do NetFlow pode ser verificada na Politica FlexConfig. Para visualizar a
configuragao, clique em Preview Config. Selecione o FTD e verifique a configuragao.



Preview FlexConfig @

Select Device:
FTD-b v

exit
IINTERFACE_END

H#HitHFlex-config Appended CLI #H#
class-map flow_export_class
match access-list flow_export_acl

flow-export destination DMZ 10.20.20.1 2055
policy-map global_policy
class flow_export_class
flow-export event-type all destination 10.20.20.1

flow-export active refresh-interval 1
no flow-export delay flow-create 1
flow-export template timeout-rate 30

Close

Acesse 0 FTD por meio do Secure Shell (SSH), use o comando system support diagnostic-cli e
execute estes comandos:

> gystem support diagnostic-cli
Attaching to Diagnostic CLI ... Press 'Ctrl+a then d' to detach.
Type help or '?' for a list of available commands.

firepower# show access-list flow_export_acl

access-list flow_export_acl; 3 elements; name hash: Oxe30fladf

access-list flow_export_acl line 1 extended deny object-group ProxySG_ExtendedACL_34359742097
object 10.10.10.1 any (hitcnt=0) 0x8edff419

access-list flow_export_acl line 1 extended deny ip host 10.10.10.1 any (hitcnt=0) 0x3d4f23a4
access-list flow_export_acl line 2 extended deny object-group ProxySG_ExtendedACL_34359742101
object 172.16.0.20 object 192.168.1.20 (hitcnt=0) 0x0Oec22ecf

access-list flow_export_acl line 2 extended deny ip host 172.16.0.20 host 192.168.1.20
(hitcnt=0) Ox1l34aaeea

access-list flow_export_acl line 3 extended permit object-group ProxySG_ExtendedACL_30064776111
any any (hitcnt=0) 0x3726277e

access-list flow_export_acl line 3 extended permit ip any any (hitcnt=0) 0x759f5ecf

firepower# sh running-config class-map flow_export_class
class-map flow_export_class
match access-1list flow_export_acl

firepower# show running-config policy-map
!

policy-map type inspect dns preset_dns_map
parameters

message-length maximum client auto
message-length maximum 512

no tcp-inspection




policy-map type inspect ip-options UM_STATIC_IP_OPTIONS_MAP
parameters

eool action allow

nop action allow

router-alert action allow

policy-map global_policy

class inspection_default

inspect dns preset_dns_map

inspect ftp

inspect h323 h225

inspect h323 ras

inspect rsh

inspect rtsp

inspect sglnet

inspect skinny

inspect sunrpc

inspect xdmcp

inspect sip

inspect netbios

inspect tftp

inspect icmp

inspect icmp error

inspect ip-options UM_STATIC_IP_OPTIONS_MAP
inspect snmp

class flow_export_class

flow-export event-type all destination 10.20.20.1
class class-default

set connection advanced-options UM_STATIC_TCP_MAP

firepower# show running-config | include flow

access-list flow_export_acl extended deny object-group ProxySG_ExtendedACL_34359742097 object
10.10.10.1 any

access-list flow_export_acl extended deny object-group ProxySG_ExtendedACL_34359742101 object
172.16.0.20 object 192.168.1.20

access-list flow_export_acl extended permit object-group ProxySG_ExtendedACL_30064776111 any any
flow-export destination DMZ 10.20.20.1 2055

class-map flow_export_class

match access-list flow_export_acl

class flow_export_class

flow-export event-type all destination 10.20.20.1
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Sobre esta tradugao

A Cisco traduziu este documento com a ajuda de tecnologias de tradugéo automatica e
humana para oferecer conteudo de suporte aos seus usuarios no seu proprio idioma,
independentemente da localizagao.

Observe que mesmo a melhor tradugao automatica nao sera tao precisa quanto as realizadas
por um tradutor profissional.

A Cisco Systems, Inc. ndo se responsabiliza pela precisdo destas tradugdes e recomenda
que o documento original em inglés (link fornecido) seja sempre consultado.



